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If you are a new user of Sage 50 
Accounts, and are not upgrading from a 
previous version, you will need to enter a 
series of opening balances. These 
opening balances are very important to 
your bookkeeping activities and you need 
to get them right. 

If you do not enter them correctly then 
your books will be wrong, although you 
can make adjustments to correct them.

Entering your opening balances needs 
certain conditions, such as your nominal 
codes, to be in place before some 
opening balances are entered.

This document takes you through the 
process of entering your opening 
balances, from gathering a list of your 
opening figures to entering the opening 
balances on your nominal, bank, 
customer and supplier records.



What are opening balances?

Opening balances are the values that make up how much your business is worth - what 
the business owns, including the amount in the bank and what it owes, and entering them 
into Sage 50 Accounts. This may mean you are transferring values from your previous 
system of bookkeeping or if you are a new company, recording the initial start up of your 
business.

The values you need to add to Sage 50 Accounts are referred to as opening balances. 
You enter these into:

 The individual records set up to manage your business dealings with other 
companies, such as your bank. You may also need to add opening balances to 
customer, supplier and product records but this depends on how you intend to use 
Sage 50 Accounts. You can find more details later in this document.

 The Nominal Ledger, which brings together all the values that make up your 
business.

If you start to use Sage 50 Accounts without entering these figures, you will not a get a 
true picture of your business finances. For instance: 

 Although you will be able to print a Profit and Loss statement using Sage 50 
Accounts, it can only calculate the results on values entered.

 The bank balance displayed by Sage 50 Accounts, when recording money in and 
out of the business will not be accurate.

 If you are going to track customers, the amount of money they owe you, displayed 
when you record a sale, will not be accurate.

 If you are going to track suppliers, the amount of money you owe them, displayed 
when you record a purchase, will not be accurate.

 The Balance Sheet, which is a snapshot of the net worth of your business, will not 
be accurate.

 If you are VAT registered, the record of VAT you owe or is owed to you by H.M. 
Revenue and Customs, or Revenue Commissioners, will not be accurate.
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How do I enter opening balances?

In this version of the software two methods of entering opening balances are available:

Method 1 - Tools menu > Opening Balances

An interactive Opening Balances Guide has been introduced to guide you through the full 
process of entering opening balances, step-by-step:

 Enter a default date for the opening balances.

 Enter opening balances for customers.

 Enter opening balances for suppliers.

 Check the opening balances.

 Reverse the nominal balances in preparation for entering the trial balance from your 
accountant.

 Enter the trial balance from your accountant.

 Enter the uncleared transactions for your bank account(s).

 Check the opening balances against the trial balance from your accountant.

 Check your data.

 Backup your data.

This method is not suitable if you are using Foreign Trader or if you are operating as a Charity 
using Funds.

Method 2 - New Record windows or Details tab on existing records

This method is suitable if you are using Foreign Trader or if you are operating as a Charity using 
Funds.
 5



Sage 50 Accounts opening balances

6

When do I need to do this?

Entering your opening balances is a one off task that should be done as soon as you start to 
use Sage 50 Accounts, although it can be done at a later date. It is more straightforward, when 
done at the start of a new accounting period. Use the following guidelines to decide on the best 
time to do this:

 Not VAT registered: choose the beginning of a new accounting period, such as the 
beginning of a month, quarter or half year.

 VAT registered: choose the start of a new VAT quarter.


Additional information for VAT registered users

 Existing business 

There are several VAT schemes supported - Standard, VAT Cash Accounting and Flat 
Rate Accounting - invoice based and cash based. Each scheme handles VAT 
differently. The VAT scheme you use will determine whether unsettled invoices are 
entered with or without a VAT amount - more about this later.

Note: If you use the Standard VAT scheme and you decide to start using Sage 50 
Accounts during a tax quarter, your first VAT Return will be a mix of VAT figures within 
Sage 50 Accounts and those in your previous bookkeeping system.

 New business

If you are setting up for the first time you may be able to claim back the VAT you have 
paid on goods and services you have bought to start up your business. To find out 
what you may be able to claim contact your local tax office.

Any start up expense with VAT that can be reclaimed is added as a regular purchase 
transaction to Sage 50 Accounts. This means you enter both the net amount and the 
VAT amount for the expense. This ensures Sage 50 Accounts generates your first VAT 
Return to include the value of such items.

How do I get started?

As a first step, you need a breakdown of your opening balances, including a trial balance.This 
is a list of all the nominal accounts you use in your business. The values (balances) on each of 
these is referred to as an opening trial balance.

If you have an Accountant, request them to prepare the opening trial balance for you. Otherwise, 
prepare a list of these figures yourself.

For more information, refer to Gathering your opening figures on page 7.
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Gathering your opening figures

Your opening figures are what the business owns - assets, and what it owes - liabilities. These 
figures are spread across the nominal accounts you have decided to use to track your business.

All businesses, regardless of the length of time they have been established, need to prepare a 
list of their opening figures. Even as a new business any investment in the business to get it 
started needs to be accounted for. The investment can come from a number of sources such 
as your own money, money you have borrowed or business grants.

Opening balances represent the financial position of your business on the day you start entering 
live transactions into Sage 50 Accounts. Whatever date you choose, you are likely to have 
opening balances, whether your business is just starting up or changing over from another 
accounting system. Opening balances are transactions that already exist before you start using 
Sage 50 Accounts. The example assumes the supplier balances equal the total for Creditors 
and the customer balances equal the total for Debtors. Normally you would expect the figures 
to match, although it is possible they may not. 

Preparing a list of opening figures

A list of your nominal accounts and the values (balances) on each is referred to as an opening 
trial balance.

 If you have an Accountant ask them to prepare the opening trial balance for you.

 If you are moving from a different accounting product you may be able to generate an 
opening trial balance from it.

 You can prepare a list of these figures yourself. Here are the steps to do this, but you also 
need to read the Breaking down opening figures section below, to help you complete this 
task. 

To manually prepare your list of opening figures
 Print the nominal list. To do this, choose Company > Nominal Ledger, then click Print List.

This gives you a list of the nominal accounts you have decided to use for your business.

 Add two columns to the print out, one for debit and one for credit.

 Refer to your previous bookkeeping method to find the value (balance) of each listed 
nominal account.

Finding the values for your bank, creditors, debtors and stock nominal accounts may 
require a little more work. See Breaking down opening figures on page 8 to find out more.

If you use the Standard VAT scheme and have decided to start using Sage 50 Accounts 
during a tax quarter, your opening figures should include an amount for outstanding VAT. 

 Write the value (balance) of each nominal account as either a debit or a credit. 
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In accounting terms, an asset to the business is recorded as a debit and a liability is 
recorded as a credit.

 Total the values in the debit column and then total the values for the credit column. The 
debit value should equal the credit value.

Breaking down opening figures

There are benefits to be gained in breaking down some of your opening figures. Breaking down 
opening figures gives you what is referred to as your opening balances. Opening balances may 
be needed for each bank account you used for the business, each customer you sell to, each 
supplier you buy from and each product you sell. The following should help you to decide if you 
need to do this.

Bank balances
          

What it is made of? Do I need to break it down?

Your bank balance may include uncleared 
items. The difference between the money 
you know you have received or have paid 
out and that shown on your bank 
statement.

Only if you want to reconcile uncleared 
items in Sage 50 Accounts.

How do I break down my balance?

 Match your bank statement to your bank records.

 List each uncleared item. 

The bank balance as shown on your bank statement is added to Sage 50 
Accounts as one amount. The uncleared items are added separately as 
individual values to Sage 50 Accounts - more about this later.

Please note: Money credited to your bank account is an asset to the business. 
Accountancy rules shows this as a debit on the bank account. This may seem odd, 
but it is how the bank account views the money. The bank account owes the 
business the amount that has been deposited; in other words it is in debt to the 
business to that amount.

On the other hand, if the bank is overdrawn, it is a liability to the business and this 
is shown as a credit balance. 
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Customer balances
          

What it is made of? Do I need to break it down?

The amount of money individual 
customers owe the business. This covers 
outstanding sales invoices, less any 
money you have received from the 
customer that has not been earmarked to 
an invoice, or it can be money you owe 
the customer for rejected goods.

If you are entering your opening balances 
at the start of the new financial year the 
total amount owed to you by all your 
customers is represented in the opening 
figures as:

 Debtors, shown as a debit value.

 Suspense, shown as a credit value.

If you are part way through your 
financial year the credit value is a 
combination of your Sales and VAT 
liability.

Only if you are going to keep customer 
records. For example if you are a retail 
outlet operating till and cash sales, you 
are unlikely to track individual customers. 

If you are going to track customers, the 
money an individual customer owes you 
needs to be recorded on their record. 
This means an accurate balance of what 
is owed by the customer is displayed 
when you start to record a sale or receive 
payments from them.

How do I break down my customer balances?

 Check your sales records for outstanding transactions (invoices, credit notes, 
payments on account).

 List customers with outstanding transactions, together with the value of the 
transaction.

 If you use the Standard Accounting or Flat Rate - Invoice based VAT schemes, 
record the transaction amount including VAT.

 If you use the VAT Cash Accounting or Flat Rate -Cash based VAT schemes, 
record both the net amount and the VAT amount for each transaction.

The total owed to you by all your customers is your opening Debtors figure. If 
the figures do not match, investigate further to try and identify the problem. If 
you can't resolve the difference it does not stop you from entering your 
opening figures, but expect warnings to be displayed by Sage 50 Accounts 
from time to time to indicate there are discrepancies.
 9
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Supplier balances
          

What it is made of? Do I need to break it down?

The amount of money you owe each 
supplier. This covers outstanding 
purchase invoices, less any money you 
have paid that has not been earmarked to 
an invoice or it can be money owed to you 
by the supplier for returned/rejected 
goods.

If you are entering your opening balances 
at the start of a new financial year the total 
amount you owe to all your suppliers is 
represented in the opening figures as:

 Creditors, shown as a credit value.

 Suspense, shown as a debit value.

If you are part way through your 
financial year the debit value is a 
combination of Purchases and VAT 
liability.

Only if you are going to keep supplier 
records. The money you owe suppliers 
needs to be recorded on their record. 
This means an accurate balance of what 
is owed is displayed for a supplier when 
you start to record purchases or make 
payments to them.

How do I break down my supplier balances?

 Check your purchase records for outstanding transactions - invoices, credit 
notes, payments on account. 

 List suppliers with outstanding transactions and the value of each transaction.

If you use the Standard Accounting - Invoice based or Flat Rate - Invoice 
Based schemes, record the transaction amount including VAT.

If you use the VAT Cash Accounting VAT (VCA) or Flat Rate - Cash Based 
schemes, record both net amount and the VAT amount for each transaction. 

Note: This does not apply if you are using the Irish VAT Cash Accounting 
scheme. If you use this scheme to calculate VAT, enter your supplier opening 
balances as described for the Standard VAT Scheme.

The total owed to all your suppliers is your opening Creditors figure. If the 
figures do not match, investigate further to try and identify the problem. If you 
cannot resolve the difference it does not stop you from entering your opening 
figures, but expect warnings to be displayed by Sage 50 Accounts from time 
to time to indicate there are discrepancies.



 Sage 50 Accounts opening balances
Product balances

Sage 50 Accounts does not link Products (stock) to the Nominal Ledger. When you record a 
product increase or decrease the quantity is adjusted only on the product record. The value of 
the product in the Nominal Ledger is not automatically adjusted at the same time. Adjustments 
to the Nominal Ledger to account for products are done using journal entries. For information 
about journal entries see your software Help system.

Entering your product balances is about adding the quantity and value of products to the 
individual product records. It is more about stock taking than it is about accounting.

          

What it is made of? Do I need to break it down?

The quantity and cost of each item you 
sell.

Only if you intend to keep product 
records. For example, a business that 
supplies car parts to the public may want 
to keep a track of how many they have in 
stock and what they cost to buy in.

How do I break down my stock balances?

 Do a stock take.

 List each product you sell together with the quantity you have in stock and how 
much it cost to buy or its current value.
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Entering your opening balances into Sage 50 Accounts

Once you know what your opening figures are, and in some cases your opening balances for 
bank, suppliers, customers and products, they are ready to be entered into Sage 50 Accounts.

Method 1 - using the opening balances window

This method is unsuitable if you are using foreign currency opening balances or if you are a 
Charity using Funds.

1. From the Tools menu, choose Opening Balances.

The Opening Balances window appears.

2. Complete each listed task in sequence. Tick each task, as you complete it.
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Task Description

Enter a default date for 
your opening balances

This date is entered automatically for you in the various data 
entry windows used to complete opening balances.

It can speed up data entry, if you intend to use the same date 
for each balance. It can still be changed, to suit.

Select a date for your opening balances. The software date is 
suggested, adjust this if required.

If you have just completed your financial year, then the 
year-end date is the most sensible date to use. For example, 
if your financial year begins in January, enter 31st December.

If you are part-way through a financial year, choose a date at 
the end of the most recent closed month. For example, if you 
are starting from June, and your financial year starts in 
January, select 31st May.
 13
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Enter opening balances 
for your customers

Enter customer opening balance values if you intend to keep 
customer records to monitor what they have purchased, and 
what they owe you.

If you operate as a retail outlet and use till and cash sales, 
you are unlikely to track customers.

These values are the amounts each customer owes your 
business, and can be found in documents, such as 
outstanding invoices.

Wen you enter opening balance values, the software records 
the double entries that are made to:

 Debtors Control Account

 Suspense Account

 Sales Tax Control Account

Standard VAT / UK Flat Rate Invoice-Based

You can enter an opening balance as a lump sum, if you are 
not interested in ageing the debt.

In the Customer Opening Balances window, you need only 
enter a Gross figure for each opening balance.

As VAT becomes liable at the point of sale, the assumption is 
that the VAT on your transactions has already been dealt with 
in your previous accounting system. During opening balance 
entry, your software applies the T9 non-vatable tax code to 
transactions. Therefore, tax is not calculated, there is no 
impact on the VAT control account, or further VAT Returns. If 
a transaction has not been VAT reconciled you should enter it 
as a new transaction in your software.

VAT Cash Accounting / UK Flat Rate Cash-Based

In the Customer Opening Balances window, you need to 
enter the Net and Tax Code for each opening balance.

The Date entry box defaults to the default opening balance 
date that you set previously.

Task Description
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Enter opening balances 
for your suppliers

These values are needed if you intend to keep supplier 
records, and want to monitor what you have purchased, and 
what you owe your suppliers.

These values are the amounts you owe each supplier, and 
can be found in documents, such as outstanding invoices.

Each item is recorded separately on a supplier’s record, so 
that it can be aged. This is useful when deciding on the 
appropriate time for payment.

Tip: If you are using either the Standard VAT or UK Flat Rate 
Invoice-Based VAT schemes, you can enter a supplier’s 
opening balance as a lump sum, if you are not interested in 
ageing the debt.

As VAT becomes liable at the point of purchase, the 
assumption is that the VAT on your transactions has already 
been dealt with in your previous accounting system. During 
opening balance entry, your software applies the T9 
non-vatable tax code to transactions. Therefore, tax is not 
calculated, there is no impact on the VAT control account, or 
further VAT Returns. If a transaction has not been VAT 
reconciled you should enter it as a new transaction in your 
software.

The Date entry box defaults to the default opening balance 
date that you set previously.

Task Description
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Check the customer 
and supplier opening 
balances

To check and confirm that the opening balances you have 
entered for your customers and suppliers are correct, select 
this icon to generate the following reports:

 The Aged Debtors Analysis (Detailed) report - use this 
report to check your customer opening balances.

 The Aged Creditors Analysis (Detailed) report - use this 
to check your supplier opening balances.

 The Period Trial Balance Report - use this report to check 
both your customer and supplier opening balances.

Check the values on your opening figures match the values on 
your generated Trial Balance. Take care over the credit and 
debit values.

What if the figures do not agree?

Example: The total balance does not match the total balance 
of my opening figures.

Possible explanation

An opening balance has been missed, duplicated or added 
as a credit, when it should be a debit or vice versa.

Task Description



 Sage 50 Accounts opening balancesDescription
Reverse the opening 
balances

At first glance, it may seem to be counter-intuitive to undo 
your customer and supplier opening balances.

The reason for doing this is related to the double entry 
bookkeeping rules. When you come to post the Opening 
Trial Balance that you receive from your accountant, the 
same values are also entered in the respective Debtors 
Control Account, Creditors Control Account and the 
Suspense Account. This will result in an inaccurate Balance 
Sheet report.

This effect needs to be reversed and cleared out before the 
opening trial balance is added.

When you select the Reverse the opening balances icon, the 
Opening Balances Reversals window appears, populated 
with a set of journals that will reverse out any entries that 
have been posted to the following nominal accounts:

 Debtors Control Account.

 Creditors Control Account.

 Sales Tax Control Account.

 Purchase Tax Control Account.

 Suspense Account.

These reversal journal entries are based on the entries that 
have been posted from the Customer and Supplier opening 
balances.

The Date entry box defaults to the default opening balance 
date that you set previously However, you can modify this 
date, if preferred.

To post these opening balance reversal journals, select 
Reverse.

The software prompts you to take a backup before 
proceeding with the reversals. It is recommended that you 
take a backup before proceeding.

Task
 17
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Enter the trial balance 
from your accountant

Selecting this icon opens the Trial Balance Entry window. 
Use this window to enter the journals for your Opening Trial 
Balance. You are likely to have received this Opening Trial 
Balance from your accountant.

A trial balance is a list of nominal accounts with the values 
entered for each account. It represents the assets that the 
business owns, and also the liabilities that it owes.

Values are spread across the nominal accounts that you 
have decided to use to track your business, such as bank, 
stock, capital and loans. It is likely to include those creditors, 
to whom your business owes money, along with debtors, 
from whom your business is owed money.

When entering a bank balance, enter both the cleared and 
uncleared items. If you want to be able to reconcile the 
uncleared transactions, you can do this on the next task.

In the Trial Balance Entry window, the Reference entry box 
defaults to O/Bal and cannot be overwritten. The Date entry 
box defaults to Opening Balance Default Date that you 
entered earlier. However, this can be overwritten.

Task Description
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Enter the unreconciled 
transactions for your 
bank account

When you select this icon the Bank Opening Balances 
window appears, in which you can enter all uncleared 
individual transactions for your bank account.

The Reference entry box (Ref) defaults to O/Bal but this can 
be overwritten if required.

Again, the Date entry box defaults to the Opening Balance 
default date that you entered earlier. You can modify this if 
required.

Standard VAT / Flat Rate Invoice-Based Accounting 
scheme

The tax code defaults to T9.

VAT Cash Accounting / Flat Rate Cash-Based 
Accounting scheme

The tax code is set to the defaults defined in Customer 
Defaults > Standard Tax Code and Suppliers Defaults > 
Standard Tax Code.

When you have entered all the uncleared transactions and 
then clicked Save, the software posts a reversing journal 
between the bank accounts and the Suspense accounts, 
and tags it as not requiring bank reconciliation. This is to 
prevent the unpresented transactions from being incorrectly 
added to those bank balances that have already been 
entered.

Task Description
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Check opening 
balances against the 
trial balance from your 
accountant

Select this icon to run the Period Trial Balance report. When 
selected, the Criteria window appears. 

To preview the Trial Balance report, select OK.

Check this report against the Trial Balance from your 
accountant to confirm that you have entered all your opening 
balances correctly.

Confirm that a Suspense Account entry does not appear in 
the report. If it does appear:

1. Print the Nominal Activity Report and use it to identify the 
error. To do this, select the Company > Nominal Ledger, 
then click Reports. Open the Nominal Activity Reports 
folder and print Nominal Activity report.

2. In the Nominal Activity Report check that all nominal 
balances from your trial balance have been entered.

3. Check that you have not duplicated any of the nominal 
balances.

4. Check that you have not entered balances as debits, 
when they should be credits, and vice versa.

5. Check that all opening balances have been entered with 
the correct date.

Check your data Although optional, take the precaution of checking the 
validity of your data files.

When you select the Check your data icon, the Check Data 
routine is run. For more information, please refer to Chapter 
of the User Guide or select F1 to display the relevant help 
topic.

Backup your data The final step, take the added precaution of backing up your 
data, in case your computer or network fails, or you suddenly 
encounter corruption.

You can always restore your data from the backup.

Task Description
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Method 2 - Entering opening balances

This method is preferred if you are using foreign currency balances or if you a Charity using 
Funds.

Entering your customer opening balances

1. Select the Customers module then, if appropriate, use the view selector to switch to the 
Customers view.

2. Select the customers you have opening balances for, then click Record.

The Customer Record window appears, showing the details of the first customer you 
selected.

3. Choose the OB button, which is attached to the Balance box.

The Opening Balance Setup window appears.

Standard VAT / Flat Rate Invoice-Based Accounting scheme

In the Opening Balance Setup window enter the following opening balance details:
          

Ref Enter the reference for this opening balance.

This reference appears on the audit trail and will help you to identify this 
transaction. If you are entering each outstanding invoice/credit note 
separately, you can enter the invoice or credit note number here. 
Alternatively you can enter O/BAL as the reference.
 21
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VAT Cash Accounting / Flat Rate Cash-Based Accounting scheme

Date Enter the original date for the transaction. This ages the invoice/credit 
note correctly by that date, so you can have an accurate picture of the 
overdue debts on all your customer accounts.

Alternatively, you can enter the last day of the previous accounting 
period. For example, the last day of the previous financial year.

Note: The date used must always be in the previous accounting period. 
For example, if you are entering your opening balances for the financial 
year commencing January 2011, the opening balance must be dated 
December 2010 or earlier.

Type From the drop-down list, select the type of opening balance you want to 
enter - Invoice or Credit.

If you owe your customers money choose Credit from the drop-down 
list. This creates a negative balance when you enter their opening 
balance. If they owe you money, choose Invoice.

Gross Enter the gross amount of the original invoice or credit note here. If you 
want to enter a single opening balance for this customer, enter the total 
gross amount of all the invoices here.

Note: Your software uses the T9 non-vatable tax code for the 
transaction. It is assumed that VAT for the transaction has already been 
accounted for in your previous accounting system. Therefore, tax is not 
calculated, there is no impact on the VAT control account, or further VAT 
Returns. 
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Tip: Press ENTER after each entry to move to the next entry box.

4. To accept these details, click Save.

To return to the Customer Record window without saving, click Cancel.

5. To return to the Customers window, click Close.

Ref Enter the reference for this opening balance.

This reference appears on the audit trail and will help you to identify this 
transaction. If you are entering each outstanding invoice/credit note 
separately, you can enter the invoice or credit note number here. 
Alternatively you can enter O/BAL as the reference.

Date Enter the original date for the transaction. This ages the invoice/credit 
note correctly by that date, so you can have an accurate picture of the 
overdue debts on all your customer accounts.

Alternatively, you can enter the last day of the previous accounting 
period. For example, the last day of the previous financial year.

Note: The date used must always be in the previous accounting period. 
For example, if you are entering your opening balances for the financial 
year commencing January 2011, the opening balance must be dated 
December 2010 or earlier.

Type From the drop-down list, select the type of opening balance you want to 
enter - Invoice or Credit.

If you owe your customers money choose Credit from the drop-down 
list. This creates a negative balance when you enter their opening 
balance. If they owe you money, choose Invoice.

Net VAT Cash Accounting / Flat Rate Cash-Based Accounting scheme

Enter the net amount of the original invoice or credit note here. 

T/C The default tax code for this customer appears here automatically, but 
you can change it if necessary.

VAT Sage 50 Accounts enters the amount of VAT due, but you can change it 
if necessary.
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Entering your supplier opening balances

1. Select the Suppliers module then, if appropriate, use the view selector to switch to the 
Suppliers view.

2. Select the suppliers you have opening balances for, then click Record.

The Supplier Record window appears, showing the details of the first supplier you 
selected.

3. In the Supplier Balance box, click the OB button.

The Opening Balance Setup window appears.

4. Enter the following opening balance details: 

Standard VAT / Flat Rate Invoice-Based Accounting scheme
          

Ref Enter the reference for this opening balance.

This reference appears on the audit trail and will help you to identify this 
transaction. If you are entering each outstanding invoice/credit note 
separately, you can enter the invoice or credit note number here. 
Alternatively you can enter O/BAL as the reference.

Date Enter the original date for the transaction. This ages the invoice/credit 
note by that date, so you can have an accurate picture of the overdue 
debts on all your supplier accounts.

Alternatively, you can enter the last day of the previous accounting 
period. For example, the last day of the previous financial year.
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VAT Cash Accounting / Flat Rate Cash-Based Accounting scheme

Type From the drop-down list, select the type of opening balance you want to 
enter (Invoice or Credit).

If you owe your supplier money, you would select Invoice from the 
drop-down box. This would create a negative balance. If your supplier 
owes you money you should select Credit.

Gross Enter the gross amount of the original invoice or credit note here.

If you want to enter a single opening balance for this supplier, enter the 
total gross amount of all the invoices here.

Note: Your software uses the T9 non-vatable tax code for the 
transaction. It is assumed that VAT for the transaction has already been 
accounted for in your previous accounting system. Therefore, tax is not 
calculated, there is no impact on the VAT control account, or further VAT 
Returns. 

Ref Enter the reference for this opening balance.

This reference appears on the audit trail and will help you to identify this 
transaction. If you are entering each outstanding invoice/credit note 
separately, you can enter the invoice or credit note number here. 
Alternatively you can enter O/BAL as the reference.
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Tip: Press ENTER after each entry to move to the next entry box.

5. To accept these details, click Save.

To return to the Supplier Record window without saving, click Cancel.

6. To return to the Suppliers window, click Close.

Check the customer and supplier opening balances

1. To check your customer opening balances, from the Customers module, click Reports.

2. From the Report Browser, select the Aged Debtors reports folder.

3. From the list of reports, print the Aged Debtors Analysis Detail report.

4. Use this report to check that you have entered the correct customer opening balances. If 
necessary, amend any entries before proceeding.

5. To check your supplier opening balances, from the Suppliers module, click Reports.

6. From the Reports Browser, select the Aged Creditors reports folder.

7. From the list of reports, print the Aged Creditors Analysis Detail report.

8. Use this report to check that you have entered the correct supplier opening balances, and 
if necessary, amend any entries before proceeding.

Date Enter the original date for the transaction. This ages the invoice/credit 
note by that date, so you can have an accurate picture of the overdue 
debts on all your supplier accounts.

Alternatively, you can enter the last day of the previous accounting 
period. For example, the last day of the previous financial year.

Type From the drop-down list, select the type of opening balance you want to 
enter (Invoice or Credit).

If you owe your supplier money, you would select Invoice from the 
drop-down box. This would create a negative balance. If your supplier 
owes you money you should select Credit.

Net VAT Cash Accounting / Flat Rate Cash-Based Accounting scheme

Enter the net amount of the original invoice or credit note here.

T/C The default tax code for this supplier appears here automatically, but 
you can change it if necessary.

VAT Sage 50 Accounts enters the amount of VAT due for you, but you can 
change it if necessary.
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Reverse the customer and supplier opening balances

In the example shown, the following balances are to be cleared from the trial balance:

1. Open the Company module, then from the Tasks pane select New Journal.

The Nominal Ledger Journals window appears.

2. Enter a reference and date for the journal, then enter the relevant data to reverse the trial 
balance figures.

Note: The date must be in the same accounting period as the customers and suppliers 
opening balances. As an example, if you are entering your opening balances for the 
financial year commencing January 2012, the opening balances are dated December 
2011 or earlier, and this reversing journal should be dated 31 December 2011.

3. To save this journal, click Save.

The journal is posted and the Nominal Ledger Journals window is cleared.

4. To close the Nominal Ledger Journals window and return to the Nominal Ledger window, 
click Close.

Print the trial balance report

1. Open the Company module. From the Links pane, select Financials > Trial.

2. Select the required output, for example Printer, then click Run.

N/C Name Debit Credit

1100 Debtors Control Account 55616.00

2100 Creditors Control Account 17817.00

9998 Suspense Account 37799.00

Total 55616.00 55616.00

N/C Name T/C Debit Credit

1100 Reverse O/Bal T9 55616.00

2100 Reverse O/Bal T9 17817.00

9998 Reverse O/Bal T9 37799.00
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3. From the Period drop-down list, choose the required Trial Balance period, for example 
Brought Forward.

4. Complete the Print window, then to print the report, click OK.

Clear the opening balances

1. Open the Company module, then from the Tasks pane, select New Journal.

2. Enter a reference and date for the journal, then enter the relevant information to reverse the 
trial balance figures.

3. To save the journal, click Save.

The journal posts, and the Nominal Journals window clears.

Enter your nominal opening balances

1. Open the Company module. From the Links pane, select Nominal Ledger, then select the 
required nominal code.

2. From the Nominal Ledger toolbar, click Record.

3. In the Details tab click O/B, then enter the opening balance information into the Opening 
Balance Setup window.

Tip: Debit balances usually include Fixed Assets, Bank Accounts that are not overdrawn, 
Purchases and Overhead accounts, such as electricity charges.

4. To save the opening balance, click Save.

The opening balance is saved and the Nominal Record appears.

Repeat this procedure until you have entered all of your Nominal Ledger opening balances.

Ref Enter a text reference. This text appears on the audit trail and will help 
you identify the transaction. The text O/Bal is entered for you as the 
default but you can change this, if required.

Date Enter the last day of your previous accounting period.

Debit Enter the debit value, if appropriate. Asset nominal ledger accounts - for 
example bank accounts, purchases and overhead accounts - for 
example electricity charges, are normally debit values.

Credit Enter the credit value, if appropriate. Liability nominal ledger accounts - 
for example loans and income accounts, such as sales of wine, are 
normally credit values.
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Enter the bank opening balances through the Bank record

If you have entered your bank opening balances through the Nominal Record, you must not 
enter them again using this procedure. Instead, refer to the next section Check the nominal and 
bank opening balances on page 29.

1. Open the Bank module, select the bank account for which you want to enter an opening 
balance, then click Record.

The Bank Record appears.

2. On the Bank Record Account Details tab click O/B in the Balance section, then enter the 
opening balance information in the Opening Balance Setup window.

3. To save the opening balance, click Save.

The opening balance is saved and the Bank Record appears.

4. To close the Bank Record and return to the Bank Accounts window, click Close.

Repeat this procedure until you have entered all your bank opening balances.

Check the nominal and bank opening balances

1. Open the Company module, then from the Links pane select Financials > Trial.

The Print Output window appears.

2. Select the required output - Printer for example, then click Run.

The Criteria window appears.

3. From the Period drop-down list, choose the required Trial Balance period, Brought Forward 
for example.

If you selected the Printer output, the Print window appears.

4. Complete the Print window as required, then to print the Trial Balance report, click OK.

Ref Enter a reference. This appears on the audit trail and helps you to 
identify the transaction. O/BAL is entered by default but this can be 
amended.

Date Enter the date. This should be the last day of your previous accounting 
period.

Receipt If you have money in this account this is a debit balance and should be 
entered here.

Payment If you are overdrawn in your bank account this is a credit balance and 
should be entered here.
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5. Use the figures from this trial balance to check that you have posted all your nominal and 
bank opening balances. You should also ensure that the Suspense nominal code balance 
is zero. If it is not, print the Nominal Activity report and check for the following:

 All nominal opening balances from your trial balance have been entered

 None of the opening balances have been entered twice.

 Balances have not been entered as debits, when they should be credits, and vice 
versa.

Check and back up your data

1. Run the Check Data option to check the validity of your data files.

Choose File > Maintenance > Check Data.

2. Take at least one backup of your data files.

Choose File > Backup.

This ensures that in the future you can restore back to this point. You may want to do this 
to check the values or details of your opening balances.

Frequently asked questions

Q. My Period Trial Balance includes a balance for the Suspense Account. What should I do?

A. Print the Nominal Activity report, then check the following:

 All nominal balances from your trial balance have been entered.

 None of the opening balances have been entered twice.

 Balances have not been entered as debits when they should be credits, and vice 
versa.

 Any opening balances that have been entered using an incorrect date.


	Sage 50 Accounts opening balances
	What are opening balances?
	How do I enter opening balances?
	When do I need to do this?
	How do I get started?
	Gathering your opening figures
	Preparing a list of opening figures
	To manually prepare your list of opening figures

	Breaking down opening figures
	Bank balances
	Customer balances
	Supplier balances
	Product balances


	Entering your opening balances into Sage 50 Accounts
	Method 1 - using the opening balances window
	Method 2 - Entering opening balances
	Entering your customer opening balances
	Entering your supplier opening balances
	Check the customer and supplier opening balances
	Reverse the customer and supplier opening balances
	Print the trial balance report
	Clear the opening balances
	Enter your nominal opening balances
	Enter the bank opening balances through the Bank record
	Check the nominal and bank opening balances
	Check and back up your data


	Frequently asked questions


